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INTRODUCTION 

Life in a prehistoric tribe is not 

easy. There are roots to dig, side 

scrapers to sharpen, spears to 

wrap, and bison hides to chew. 

All exhausting work. So, when 

Friday rolls around ... well, there 

are more side scrapers to 

sharpen and pots to fix and grubs 

to catch. Yahoo. 

But hold 00. 

Belchfire Mountain, the lovely 

volcano that overlooks your 

village, is grumbling. She rocks 

and coughs and suddenly 

explodes, spewing fire and ash 

high into the air. People scream 

and run everywhichway, as the 

village tumbles down around 

your ears. Lava licks at your 

heels as you scramble into the 

forest, which soon catches fire, 

and run to the relative safety of 

the nearby hills. By evening, you 

collapse, exhausted, and look 

back to watch the destruction of 

your homeland framed by the 

setting sun. 

Gradually, others from your 

village gather and you spend a 

fitful night dodging lava sparks 

and listening to the tribal elders 

argue. By morning, it has been 

decided. Your homeland has been 

destroyed. Your tribal leader was 

encased in lava, as were most of 

the tribe's best hunters. Those 

few who survived are scared and 

hungry. You awake, yawning and 

stretching, -to find the elders 

looking at YOU. 

As the brightest and strongest 

young person left, you have been 

chosen to lead your tribe to a 

new home in a distant land. 

The only hope for the survival of 

your people is to travel to an 

ancient land that 

may exist only in 

tribal legend -

the volcanic 

paradise that 

gave birth to 

your ancestors. 

To safeguard 

your future, 

you must 

discover your 

past. 

As the new 

leader of the 

Lost Tribe, you 

must make the 

decisions that affect 

the welfare and 

happiness of your 

people and 

determine if you will 

arrive safely at your 

destination. 

_______ L __ ~J ___ ~---.. -_____________ .. ____________________________________________ ------__ 

It will not be an easy task. The way 

is fraught with danger, and the 

unexpected lurks around every 

turn. You will choose the direction 

you'll travel and will decide how 

each day of the journey is spent. 

You must learn to balance the 

need for both work and leisure, to 

deal with the varied personalities 

of your people as they interact 

with one another, and to use all 

your resources in the struggle 

to survive. 

Everyone is 

counting on 

you. The fate of 

the world is on 

responsibility, 

but at least you 

won't have to 

sharpen any more 

side scrapers. 

ARE YOU 
UP TO THE 
TASK? 



LOADING THE 
PROGRAM 

IBM I Required Equipment: 

t/ IBMlfandy or 100% 
compatible computer. 

t/ A hard disk with at least 5MB 
free space. 

t/ A VGA or MCGA monitor and 
graphics card. 

t/ One 720K 3.5", or one 102M 
5.25" disk drive. 

t/ 500K of free regular memory. 
t/ MS-DOS or PC-DOS 3.1 or 

higher. 
t/ A keyboard or Microsoft­

compatible mouse. 

'tHE LOST TRIBE contains both 
102M 5.25" disks and 720K 3.5" 
disks. If your disk drive cannot 
read 102M 5.25" disks, you may 
exchange them for 360K 5.25" 
disks at no additional charge. 
Please send the 102M 5.25" disks, 
a copy of your sales receipt, and 
your name and address to: 

Lawrence Productions, Inc. 
1800 South 35th Street 
Galesburg, MI49053 
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Sound: 

Music and sound effects in THE 
LOST TRIBE have been pro­
grammed to Ad Lib standards. If 
you have an Ad Lib or Sound 
Blaster board, you'll get higher 
quality sound. Other "compatible" 
sound boards may work just fine, 
but we cannot guarantee it. If 
you have a compatible board that 
does not work with THE LOST 
TRIBE, consult your board's 
manual first, then call the man­
ufacturer for further assistance 
if necessary. 

Even without an optional 
sound board, THE LOST TRIBE 
can play digitized sound effects 
through your internal speaker. 
However, you must have at least 
an 8Mhz 286 machine, and you 
can not be running the program 
from Microsoft Windows in 
Enhanced mode. If you have an 
optional sound board, you can 
switch back and forth between it 
and the internal speaker by 
hitting Control-A at any time 
during running of the program 
except during an animation. 

Troubled Rodents: 

Most mice claim to be Microsoft 
compatible, but a lot of 

them simply are not. 
We have made 
every effort to 

support as broad a 
range of mice as 

possible. If your mouse 
is one of the few that 

does not work with THE 
LOST TRIBE, try the "1M" 

switch when starting the 
program; if it still doesn't 

work, use the "/K" switch to 

enable the keyboard instead. (See 
Switches, below, for a complete 
list of optional switches.) 

Hard Drive Installation: 

THE LOST TRIBE has no on-disk 
copy protection, but the files on 
the original disks are compressed. 
This means you cannot run THE 
LOST TRIBE from a floppy drive; 
you must install it onto-a hard 
disk to run the program. 

To install THE LOST TRIBE onto 
your hard disk, follow these brief 
instructions: 

1. Exit out of any programs you 
may be running, including 
Windows, the Dosshell, or any 
other menu type program. 

2. Insert Disk 1 into your A drive. 
(You may install the program 
from your B drive as well; just 
substitute "B" for "A" in these 
directions.) 

3. Change to the A:\:> prompt by 
typing A: 

4. Now type INSTALL (upper 
case or lower). 

5. Follow the onscreen prompts 
for choosing a drive and 
directory, and swapping disks. 
(You may install the program 
in a different directory from 
TRIBE, which is the default, 
by backspacing over that name 
and substituting any name or 
path you like.) 

Startin, THE LOST TRIBE: 

1. Exit any programs you may be 
running, so that you are at the 
DOS prompt. (To run THE 
LOST TRIBE from Windows, 
consult your Windows manual 
on how to run DOS programs 

and how to create a PIF.) 
2. Change to the drive and 

directory in which you 
installed THE LOST TRIBE. For 
example, type CD \TRIBE 

3. Now type TRIBE and press 
Enter. The program will begin 
loading. (See Switches also.) 
After the title screen and 

opening sequence, you will see 
the Options Screen where you 
may choose a scenario. Click on 
any of the six scenario names and 
a brief description will appear in 
the text window below (scenarios 
are listed in order of difficulty; 
we recommend playing 
"Grandfather's Route" first). 

Mter you've chosen a scenario, 
click on New Game on the right 
side of the window, then on 
LOAD at the bottom. (See Saving 
and Loading Games 
for additional 
information.) 

Once you've played 
THE LOST TRIBE a 
few times, you may 
wish to skip the 
introductory 
animations. To do so, 
click your left mouse 
button (or hit Enter if 
using the keyboard) 
once the title screen 
appears. 

Quitting: 

To quit THE LOST TRIBE, 
go to the Options Screen 
by choosing the Options 
button on the main 
screen. Then choose 
the "Quit to DOS" 
button. Alternately, you 
may exit to DOS 
from anywhere in 

the game by pressing Control-Q. 
Be sure you have saved your 
game before quitting if you want 
to resume it later; quitting by 
either method exits immediately 
to DOS without asking for 
confirmation or giving you a 
chance to change your mind (we 
assume you're quitting because 
that's exactly what you wanted 
to do). 

THE OPTIONS SCREEN 

On the Options Screen, you may 
save a game in progress; view 
scenario descriptions and load a 
scenario or Silved game; view a 
scenario's high scores; turn all 
sound on or off; and quit to DOS. 
To view the Options Screen, 
select the Options button on the 

main screen. 

Saving Games: 

THE LOST TRIBE 
allows you to save 
up to five games in 
each scenario._ 

Each saved 
game occupies a 
"slot" (above 

"New Game") on 
the Options 
Screen. An empty 
slot has a triple 
dash in it; a filled 
slot has the name 

of your saved game. 
You'll note that the 

slots are color-coded 
to match each 
scenario name as 
you select it. 

To save a game in 
progress, go to 
the Options 

Screen and choose an empty 
slot. If there are no empty slots, 
you may still save your game 
by choosing a filled slot; your 
current game will replace the 
previously saved game in 
that slot. 

Mter you've chosen a slot, hit 
the Save button, then type a 
name for your game (using 
letters, numbers and/or spaces), 
and press Enter. 

Loading a Saved Game: 

To load a saved game, go to the 
Options Screen and choose the 
appropriate scenario. Select the 
name of your saved game from 
the list on the right, then hit the 
Load button. Your saved game 
will be loaded and you'll be 
returned to the main screen. 

Using a Mouse: 

If you have a mouse driver 
loaded, THE LOST TRIBE will 
automatically use it. To select an 
icon or button during play of the 
game, press the LEFT mouse 
button. 

SPECIAL "SELECT ALL" -
during the Hunting/Gathering 
action, you may select "all 
available hunters" by placing the 
cursor over the spear icon and 
pressing the RIGHT mouse 
button; you may choose "all 
gatherers" by placing the cursor 
over the basket icon and pressing 
the RIGHT mouse button. 
Likewise during the Make 
Spears/Practice action you may 
select "all available" by pressing 
the RIGHT mouse button while 
the cursor is on the spear icon or 
on the target icon. 
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Using a Keyboard: 

THE LOST TRIBE will only enable 
the keyboard for game play if you 
have no mouse driver loaded or if 
you start the program with the 
IK switch (see below). To move 
from button to button, use the 
arrow keys, or the 2, 4, 6, and 8 
keys (with NUM LOCK off). Press 
the Enter key or Spacebar to 
make a selection. 

SPECIAL "SELECT ALL" -
during the Hunting/Gathering 
action, you may select "all 
available hunters" by moving the 
cursor to the spear icon and 
holding the SHIFT key down 
while pressing the Enter key or 
Spacebar; you may choose "all 
gatherers" by moving the cursor 
to the basket icon and holding 
down the SHIFT key while 
pressing the Enter key or 
Spacebar. During the Make 
Spears/Practice action you may 
select "all available" in a similar 
fashion while the cursor is on the 
spear icon or on the target icon. 

Viewing the Map: 

Only a portion of the map is 
shown in the main window. To 
view the entire map, place the 
cursor anywhere within the main 
window over the map and press 
your RIGHT mouse button. If 
you're using the keyboard, move 
the cursor to the map and hold 
down the SHIFT key while 
pressing Enter. 
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Button Help: 

During play of the game, you 
may obtain a brief explanation of 
the symbols on any button: 
1. If you're using the keyboard, 
move the cursor to that button 
and hold the SHIFT key down 
while pressing the Enter key 
or Spacebar. 
2. If you're using a mouse, place 
the cursor over the area and 
press the RIGHT mouse button. 
Status Rock and Leadership 
Rock help is also available for 
mouse users. 

Special Options: 

THE LOST TRIBE includes a 
number of "switches" which may 
be used when loading the 
program. These switches are 
designed to overcome hardware 
incompatibilities or to give you 
optional control over how the 
program runs on your machine. 

Switches may be used in any 
combination, as many as you 
require. To use a switch, add it to 
the command line when you 
begin the program, with each 
switch separated by a space. For 
example, to run THE LOST 
TRIBE with a keyboard and 
provide faster screen fades, at 
the command prompt type: 
TRIBEIKIF 

The complete list of switches 
follows: 

IC If you have color VGA, but see 
only grays. 

IF Provides faster fades on fast 
video cards. 

IG Fixes Genius version 7.x mice. 

IK Enables keyboard and 
bypasses mouse check. 

1M If you have a mouse but don't 
see a mouse cursor. 

IP Changes screen fades to 
speckle-clears (helps on 
slower machines, or if you 
just prefer speckles to fades). 

IS Reduces flicker during 
screen transitions on slower 
video hardware. 

During running of the 
program, you may use Control-A 
to switch from your optional 
sound board (Ad Lib) to the 
internal speaker and vice versa. 
Also, Control-Q quits the 
program. 
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MACINTOSH I Requirements 

Macintosh LC, LCn, n Family, 
or Quadra computer. A 256-
color monitor. At least 1MB free 
on your hard disk. System 6.0.5 
or above. 

Installation: 

The files on the distribution 
disks are compressed, which 
means you cannot run the 
program from the disks. To 
install them on your hard drive, 
please follow these instructions: 

1. First, turn off any virus-
protection programs, such as 
Gatekeeper, you may have 
running. These programs will 
only cause spurious messages to 
appear during the installation 
process, and in some cases may 
prevent installation entirely. If 
you forget to turn them off, 
ignore the messages that come 
up and simply continue. Both 
the Lost Tribe program and the 
Lost Tribe installer have been 
thoroughly tested for known 
viruses with the latest programs 
available at release time. 

2. Insert Disk 1 into your floppy 
drive. Double-click the "Tribe 1" 
disk icon, if necessary, to display 
its window. 

3. Copy the file named "Tribe 
Installer" to your hard drive by 
selecting the "Tribe Installer" 
icon in the Tribe.1 window and 
dragging it into your hard drive 

window (open your hard drive Saving a game: 
window first; if it is not already 
open).After the file has been To save a game in progress, the 
copied, close the Tribe.1 window. mapskin must be in the main 

window at the beginning of a 
4. Now double-click the "Tribe turn. Pull down the File menu 
Installer" icon in your hard drive and choose Save; then, type in 
window. A scrollable message a name for your saved game. 
window will appear. Please read 
the notes before proceeding. Loading a previously-saved 

game: 
5. When you are ready to 
proceed, click on Install. To load a saved game, double-

click on its icon in your Tribe 
6. You will be prompted to folder. If you are already in The 
insert Disk 2; insert The Lost Lost Tribe program, you may 
Tribe Disk 2. choose Open from the File menu 

and then select the desired game 
7. Follow the prompts for the from the file dialog. 
remaining disks (at the end of the 
process you will insert Disk 1 for Choosing a different 
a second time). scenario: 

8. When all the files are Pull down the Options Menu 
extracted, the installer will and choose one of the scenarios 
return you to the desktop. Drag listed. (The scenario you are 
the "Tribe Installer" icon from currently playing will be check-
your hard drive into the trash; marked.) Then choose "New" 
you won't be needing it any from the File Menu. 
more. 

Balloon Help: 
9. Now to start playing, open the 
"Tribe Folder" on your hard disk If you are running under System 
and double-click The Lost Tribe 7 or above, you may turn 
icon to start the game. Balloon Help on to get a little 

help with the various buttons 
Quitting: and screen areas. 

To quit a game in progress, 
pull down the File menu and 
choose "Quit," or simply press 
Command-Q. 
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This page intentionally left 
blank. 

(Isn't every software manual 
supposed to have one of these?) 
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THE SACRED MAPSKIN 

The Sacred Mapskin was prepared 
by the tribe's founders as they 
made their way along the edge of 
a great glacier many centuries 
ago. They thought it important 
to preserve for their descendants 
some record of their 
unprecedented journey. You will 
use the Sacred Mapskin to plot 
your path to your new home. 

Cartog, who was responsible 
for painting the mapskin, tried as 
best he could to represent the 
different types of terrain 
encountered along the way. He 
was extraordinarily bright and 
was well-versed in the esoteric 
ss;ience of geometry. So, 
whenever the tribe came into 
different terrain, Cartog drew a 
hexagon shape in which he 
placed a symbol representing the 
area covered by that terrain type. 
(In later scenarios where the 
whole map is not visible, a 
member of your tribe will record 
your journey using Cartog's 
hexagon method.) Cartog 
determined there were 10 basic 
terrain types: 

Mountains - high, rocky 
mountains with narrow passes. 
Mountains are quite dangerous 
and afford little opportunity for 
hunting or gathering. 

Hills - rolling hills with few 
trees and lots of good grass for 
grazing. Hills are fairly easy, 
although tiring, to cross. 
Mammoths tend to make their 
homes in the hills. 

Wooded Hills - steep, 
tree-covered hills. These areas 
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are not as dangerous as 
mountains, but many bears live 
here and the woods make for 
difficult travel. 

Forests - thick stands of trees 
that stretch for miles. Forests are 
the richest areas for gathering 
food and hunting deer and small 
game. You never know how 
dangerous a forest is until you're 
in the middle of it. 

Plains - long stretches of flat 
grasslands. Plains are home to 
bison, boar and other grazing 
animals. They are quite safe for 
travel. 

Rivers - twisting ribbons of 
clear, cold water that wind 
through forests and plains 
providing nourishment for the 
surrounding areas. Many animals 
come to the river to drink and 
bathe, and fish, of course, can be 
caught in the shallower areas. 

Lakes -large bodies of fresh 
water completely surrounded by 
land. Fish are always abundant 
and the larger, less skittish 
animals tend to drink and bathe 
in lakes. 

Volcanoes - mountains that 
are capable of belching fire, but 
are dormant for now. This area of 
the world is dotted with many 
volcanoes, and because of their 
seemingly miraculous nature, 
your tribe has tended to settle 
around them. 

Impassable Mountains - high 
areas that cannot be entered by 
man or beast. You'll have to go 
around these areas. 

Impassable Water - huge 
bodies of water, seemingly 
endless, and suitable only for 
whales and sea monsters. You 
can't enter these oceanic areas. 

Villages - not actually a terrain 
type, but worthy of separate 
symbols on the mapskin. These 
settlements of other tribes were 
abandoned centuries ago. 

Each terrain type has advantages 
and disadvantages for hunting 
and travel. Part of your challenge 
is to learn what terrain is 
conducive to travel and which 
areas are easier to survive in. For 
some additional help, you might 
consult your Prehistoric Guide to 
Survival. 

THE ROCK DISPLAYS 

Grampf, as the eldest member of 
the tribe, keeps track of 
important things to help you in 
your planning. These are 
recorded on two rocks which he 
carries and paints as things 
change. The two rocks are the 
Survival Rock and the Status 
Rock. 

On the Survival Rock, Grampf 
records: 

People: 
Your tribe consists of 23 people 

} 

_________ L ___ _ 

----------

who are old enough and strong 
enough to hunt or otherwise 
contribute to the welfare of the 
tribe. Certainly there are very 
small children present, but Grampf 
does not keep track of them since 
they have not yet reached 
"adulthood" and are incapable of 
surviving on their own. 

Food: 
Food is counted in portions, with 
one portion equal to the amount 
one person eats in a single day. 
Thus, if your tribe has 18 people, 
it will take 18 food portions to 
feed them each day. You may 
choose to eat only partial rations 
on a given day, or none at all, but 
this will usually make people 
unhappy. 

When you travel, each person 
can carry only three days' worth 
of food. You may accumulate as 
much food as you want at a 
single campsite, but you'll leave 
behind any that can't be carried. 
For example, say you have 100 
units of food and 18 people in 
your tribe. If you choose to move, 
you can carry only 54 units of 
food with you,leaving the other 
46 units behind. To use excess 
food you may declare a day of 
feasting, which everyone will be 
happy about. Alternately, you 
may move on and leave the 

excess food behind, at the risk of 
losing some leadership status. 

Spears: 
Spears are used for hunting. Only 
people who have spears can hunt 
for game. Spears are often lost or 
broken whjle moving or during a 
hunt, ~ut they can be replaced if 
you take a day to do so. 

As with food, you can have as 
many spears as you want at a 
single campsite, but when you 
move, each person can carry only 
TWO spears. Excess spears left 
behind cannot be recovered 
should you return to the area; 
they have disappeared into the 
hands of the Junkopithicus tribe 
which also lives in this part of 
the world and specializes in 
finding discarded tools. 

Hunting Skill: 
Your Hunting Skill determines 
how likely you are to bag an 
animal once you've spotted signs 
of it in an area. Since the best 
hunters in the tribe were caught 
in the lava flow that destroyed 
your homeland, your skill at the 
beginning of a scenario is 
minimal. You can increase it by 
choosing the Make Spears / 
Practice action and having some 
tribe members practice. The 
more people that practice, the 
higher your skill will go. 

Current Area 'l)tpe: 
This hexagon-shaped symbol shows 
the area type you currently occupy 
(as it would appear underneath the 
tribe icon on the mapskin). 

Current Area Hunting: 
This is an estimate of how good 
the hunting is in your current 
area. The thermometer-like 
symbol will reflect either good, 
fair, or poor hunting. 

Current Area Gathering: 
This is an estimate of how good 
the gathering is in your current 
area. The higher the color in the 
thermometer symbol, the more 
vegetation there is in the area 
to gather. 

On the Status Rock, Grampf 
keeps a running record of how the 
tribe feels about your leadership 
and how long you have before 
winter sets in. 

TIme: 
Grampf has estimated the number 
of days remaining before the onset 
of winter makes further travel 
difficult and, eventually, 
impossible. He has recorded this 
beside a symbol of the sun. Once 
this number reaches 0, hunting 
and gathering will become more 
difficult and you will have only a 
few weeks at most to find your 
new home before people panic and 
choose someone else to lead them. 
Even if that doesn't h~ppen, winter 
will eventually overtake you and 
you'll freeze to death. 

Each turn in the game 
represents ONE DAY (although if 
you are moving cautiously to a 
new area, the turn is two days). 
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Leadership Rating: 
Your Leadership Rating, which is 
displayed as a thermometer-like 
symbol, is a measure of the 
tribe's confidence in your 
long-range leadership abilities. 
Throughout the game, depending 
on what decisions you make, 
your Leadership Rating will rise 
and fall. The higher it is at the 
end of a scenario, the better your 
overall score will be. If your 
rating ever reaches zero, it's 
because the tribe has lost all faith 
in you and will replace you with 
someone else. You begin the 
game with a favorable rating, 
which reflects the tribe's decision 
to appoint you as leader. 

Happiness: 
The Happiness symbol, a Smiley 
face, indicates how pleased the 
. tribe is with your leadership in 
the short term. This rating, sort 
of a popularity poll, will fluctuate 
dramatically based on your day­
to-day decisions. While people 
are certainly interested in your 
vision and long-term planning, 
they are also concerned about 
their more immediate needs, 
especially for food. 

The Happiness symbol appears 
in five different states, from a big 
smile toa big frown. If the people 
ever get so unhappy that even a 

frown doesn't their 

journey will be spent. You may 
choose one action each day since 
all actions, except Scouting, 
require a full day (one turn) to 
complete and the participation of 
the whole tribe. 

The buttons on the main 
screen are used to select what 
action the tribe will perform each 
day. Each action is described in 
detail below. Buttons on the 
main screen include: 

Hunt / Gather 
Make Spears / Practice 
Leisure 
Carve 
Survival Guide 
Options (IBM only) 

In addition, highlighted hexes 
next to the tribe icon on the map 
are buttons which are used for 
movement and scouting. 

Move: 
The mapskin, made from a 

number of hexagons (also called 
hexes), is always present in the 
main window. A stone icon, rep­
resenting your tribe's current lo­
cation, 
map. To 
jacent 

scout the selected area (see 
Scout, below, for details). 

Whenever you move into a new 
area there is a chance you will 
lose some food, spears, or one of 
your people. How likely you are 
to lose something depends on 
how dangerous the new area is 

J and how quickly you are moving 
through it. In general, mountains 
are the most dangerous, followed 
by areas covered with trees or 
containing rivers; hills and plains 
are the safest. You can reducethe 
danger in an area by moving 
cautiously. 

Scout: 
Scouting allows you to find out 
about areas that lie ahead 
without actually moving into 
them. A scouting party consists 
of four people. Scouts go out one 
morning and come back the next, 
so you'll be without them all day. 
When they return, after they've 
eaten, they will tell you how 
dangerous the scouted area is 
and how good the hunting in the 
area is. You will also be able to 
see what kind of terrain lies in 
areas adjacent to the scouted area 
(two hexes away from your 

location - this only 
with hidden 

(don't worry if you decide to 
move; your scouts will catch up 
with you tomorrow). 

When the scouts return 
tomorrow, they will immediately 
report their findings and the hex 
that was scouted will have a blue 
border around it as a reminder 
that you've scouted that hex. You 
may click on any blue-bordered 
hex to review the scouting report 
at a later time. 

Hunt I Gather: 
When the Hunt / Gather button 
is selected, a cave wall will appear 
on which are painted the various 
animals you may hunt for. Below 
the animals are symbols for each 
member of the tribe, and next to 
them are pictures of a spear and 

. a gathering basket. To send the 
whole tribe gathering, simply 
click on the "Continue" button. 

To send out a hunting party, 
first choose an animal to hunt 
for, then click on the spear 
symbol to hand out spears to 
your hunters. You may take only 
as many hunters as you have 
spears (and people, of course); 
anyone who does not hunt will 
gather instead. You may click on 
the basket symbol to turn a 
hunter back to a gatherer or 
choose a different animal if you 
like. When you have everyone 
doing what you want them to, 
choose the "Continue" button. 

A successful hunt depends on 
the number of hunters involved, 
the difficulty of catching the 
chosen prey in the current area, 
your current hunting skill, and a 
small amount of luck. Hunting 
almost always involves some risk. 
You may lose a number of spears 
or a hunter might be killed, if the 

prey is particularly dangerous. 
Gathering will always yield some 
food but the amount depends on 
how much gatherable vegetation 
is in the area. 

Make Spears I Practice: 
As you travel and hunt, spears 
will get broken or lost. You may 
replace them by organizing a day 
of spear-making. Each person 
may make one spear per day, and 
you may carry up to two spears 
per person when you move. 

If you already have some spears 
"in stock," you may have some 
tribe members practice their 
spearing techniques. The number 
of people who may practice is lim­
ited to the number of spears you 
have in stock. The tribe's Hunting 
Skill level increases depending on 
how many people practice. 

After selecting the Make Spears/ 
Practice button on the main 
screen, a painted cave wall will 
appear showing a symbol for each 
member of your tribe, along with 
a target and a spear. The maxi­
mum number of people who can 
practice is shown next to the 
target symbol. 

To have the entire tribe make 
spears, simply click on the 
"Continue" button. To have some 
people practice, click on the 
target symbol. Clicking on the 
spear symbol will turn practicers 
back into spear makers. When 
you have divided your people as 
you wish, select the "Continue" 
button to proceed. 

Leisure: 
Surviving in prehistoric times 
was hard work, even as it can be 
today. But all work and no play 
can make for some seriously 

unhappy people. When you work 
hard, you can reward yourself 
and your tribe with a day of rest, 
then everyone will feel more 
refreshed when it's time to 
resume the battle for survival. If 
you manage to bag a mammoth 
or otherwise accumulate a large 
quantity of food, you may even 
have a feast. The tribe will spend 
the day in games and recreation 
and gorging themselves on food. 

After choosing the "Leisure" 
button you must then decide 
either to rest, without eating 
anything extra, or to have a feast. 
If you choose to feast, you must 
select how many EXTRA portions 
of food you will eat during the 
feast - one, two, or three extra 
portions, depending on how 
much food you have. Generally, 
the bigger the feast, the happier 
everyone will be. 

Since feasting occurs through­
out the day, you must still decide 
what to do for supper. If you dole 
out anything less than a regular 
day's portion, the effects of your 
feast will be somewhat diminished. 

Carve Figures: 
Carving figures out of wood and 
stone boosts the tribe's con­
fidence in their ability to hunt a 
particular animal and provides 
some mystical satisfaction. You 
may carve animal figures, which 
may increase your chances for a 
successful hunt in your current 
area, or Venus figures, which will 
shore up the tribe's spirits and 
add greatly to your status as 
a leader. 

Since this activity requires the 
concentration and efforts of all 
tribe members, you may carve 
only one type of figure each day. 
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When you choose the "Carve" enter them. happy the people are, your People, 69 Food (enough to feed You'll notice the rock buttons on Assuming a random event does 
button, a cave wall will appear, If your ancestors passed Leadership rating, and the them for three full days), and 14 the right side of the screen have not come up first (if it does, 
on which are representations of through a particular village, you number of days remaining before Spears - these three numbers changed. To move, we must resolve it as you wish), an 
the figures you may carve. Select will find markings indicating winter. If your score is high are very important, so you'll want choose one of the top two rocks animated cavewall painting will 
one of the figures by clicking on their progress. From their enough, you may even get into to watch them closely - the first one to move at a graphically display the results of 
it, then choose the "Continue" records, you can determine how the Lost Tribe Hall of Fame throughout the game. Below normal pace, the second one to the hunt and a text description 
button. far away you are from your new which lists the top six scores in Spears you'll see that your move cautiously. The fourth rock will appear below. Choose a day 

If you carved an animal, you home - IF you can decipher each scenario. Hunting Skill is minimal, and is used to send out a scouting end button to end the turn, then 
may want to go hunting for it the the symbols. that you are still in the area of party. This time, let's hit the top examine the Status rock to see 
next day. Your chances of If your ancestors left no A SAMPLE TURN the volcano, which now has poor button. what your current situation is. 
bagging one, providing there are markings in the village, you will hunting and moderate gathering The tribe icon moves into the From this point, you may 
any at all in the area, will be know you are not on the same This sample turn is intended to (due to the animals which failed forest hex you chose, and the move or hunt again, or perform 
better, but the effects last for path they took. You may, however, familiarize you with the basic to escape the area). On the rock buttons change again to any of the other actions available, 
only one day of hunting. discover a great hunting secret flow of play. For more detailed Leadership Rock, Grampf has show the day end options. such as Carving or Practicing 

known only to the tribe that lived information about the actions indicated that there are 75 days Ending the day involves a your spear throwing. The 
RANDOM EVENTS in that village long ago. From that you may take and the decisions left until the seasons change. decision about how much to eat decision is yours. 

day forward, your skill will be at you will face, see the individual Your Leadership rating reflects before you go to sleep. Choosing 
Your actions each day may be its best when hunting for the sections above. For the purposes your recent promotion, and the the top rock will feed everyone a WHAT MAKES A 
interrupted by random events. animal depicted in the secret of this example, we will assume people are happy just to be alive full portion of food; choosing the HAPPY TRIBE 
Semetimes a dispute will break painting. that you are playing the IBM and have a plan, as indicated by second gives everyone a 
out or you'll stumble across version and using a mouse. If you the Smiley face. half-day's ration; the third rock Things that positively affect your 
some amazing thing. All random ARRIVING AT PARADISE are using a Mac or a keyboard In the center of the screen is sends everyone Leadership Rating: 
events call for a decision on your (IBM only), see the sections the Sacred Mapskin, held in your to bed without any supper. + Resting 
part. When an event occurs, Keep in mind that no single above describing those controls. own two hands. Move the mouse Choose the full portions rock to + Feasting 
you'll see a snapshot of the decision or action will cause you After loading the game and cursor anywhere over the map complete your first day as leader + Carving an animal that 
occurrence with text below that to lose the game. However, a watching the title screen and and press the RIGHT mouse of the Lost Tribe. inhabits the area 
describes what's happening. At series of events or poorly chosen opening animations, you'll find button; the whole map will Now, let's go hunting. Choose + Carving Venus figures 
the end of each event description actions, coupled with a little bad yourself looking out over your appear. Your tribe icon is the top rock on the right side of + Entering a village 
are two or more choices, lettered luck, can end the game for you. devastated home and the highlighted on the far left of the the screen (it has a spearing + Random event decisions 
A through D; choose one of them If your Leadership Points reach still-bellowing volcano that map, and on the far right, you'll hunter on it). A cavewall appears 
to resolve the event and then 0, or if you haven't found a home destroyed it. You may scroll see a volcano - that's your with pictures of the animals you Things that negatively affect your 
read the results of your decision. shortly after the onset of winter, through the introductory text by destination. To get there, you can can hunt for and a symbol for Leadership Rating: 

Some events will take all day the elders will replace you with clicking on the up or down take the high road beside the each member of your tribe. Next · Leaving food behind when 
to resolve; others may be someone else and you will be arrows. When you're ready to mountain range, the low road to the people symbols, the moving 
resolved instantly. In any case, banished from the tribe. You may move on, click on the "Continue" along the huge lake, or go right numbers of hunters and · Eating more or less than the 
your Leadership Rating will be also be banished ifthe people button (looks like a pointing through the clump of mountains gatherers are indicated. optimal amount of food 
affected (up or down) and you become extremely unhappy, hand). in the center - it's up to you to Click on the picture of the Allowing people to remain 
may gain or lose food, spears or which usually occurs if they The list of scenarios is now decide. For now, press a mouse rabbit; one of the people changes "unhappy" 
even people. are starving. displayed. Click on them one at a button to return to the regular from a gatherer to a hunter. Now, · Random event decisions 

If, however, you manage to find time to see a brief description of playing screen. click on the spear symbol a few Things that positively affect 
VILLAGES: Keys to the Past your ancestral paradise, you'll each. Then choose "Grandfather's The first thing we should do times (see Macintosh Technical Happiness: 

win your tribe's love and respect Route" and hit the LOAD button. now is get away from the information if you have a Mac) to + Eating FULL portions when 
During your journey you will and will be made Leader for life. The map for Grandfather's Route volcano, before further increase "the number of hunters. there is plenty of food 
encounter several remains of A numerical score will appear on will be loaded and the initial destruction rains down upon us. You'll only be able to hunt with + Resting 
ancient civilizations. These the Status rock. It is based on scenario settings will appear on There are three highlighted hexes as many people as you have + Feasting 
abandoned villages always how many people survived the the Status and Leadership Rocks. next to the tribe icon - choose spears, and the rest of the people + Entering the Venus village 
contain some bit of useful trip, the amount of food and Take a moment to examine the the middle one (forest) by will gather. When you're ready, 
information, if you care to spears you arrived with, how Rocks. Notice that you have 23 clicking on it with the mouse. click on the "Continue" button. 
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Things that negatively affect 
Happiness: 
• Losing a hunter 
• Leaving food behind when 

moving 
• Eating more or less than the 

optimal amount of food 
Eating nothing, whether 
there's food or not 

THE PREHISTORIC GUIDE 
TO SURVIVAL 

The Prehistoric Guide to Sur­
vival is a 100-page online illus­
trated encyclopedia packed with 
information about the world of 
THE LOST TRIBE (and our mod­
ern world as well). The Guide 
is..divided into 10 topic sections, 
each of which includes 10 
individual items. 

Some of the Guide's topics, 
like Personality Profiles, Pre­
historic Animals, and Lay of the 
Land, may help you in playing 
THE LOST TRIBE. You may learn 
what animals to hunt in which 
areas, or gain some insight into a 
particular character's personality 
that will help you resolve a ran­
dom event. Other topics should 
prove informative and may even 
spark your interest in further 
investigation. As a next step, you 
might check out some of the 
books in our Recommended 
Reading list. 

Topics and Items in the 
Prehistoric Guide are: 

Personality Profiles 
B'Kaar 
Bloog 
Brogo 
Burgle 
Glurg 
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Gnarf 
Grampf 
Gupf 
Gurble 
Targ 

Tribal Legacy 
Integration 
Coexistence 
Return of the Tribes 
Tribal Nations 
Cycle of Conflict 
Link to Land 
Values 
Identity 
The Environment 
Tribal Inheritance 

Lay of the Land 
Forest 
Hills 
Impassable Terrain 
Lakes 
Mountains 
Plains 
Rivers 
Villages 
Volcanoes 
Wooded Hills 

Art &: Artifacts 
Alphabets 
Calendars 
Cavewalls 
Crystal Skulls 
Dinosaur Bones 
Dolmens 
Leader Batons 
Prehistoric Aesthetics 
Stone Circles 
Venus Figures 

Prehistoric Animals 
Bison 
Boar 
Cave Bear 
Deer 
Fish 

Horse 
Mammoth 
MuskOx 
Rabbits 
Woolly Rhinoceros 

Tools &: Utensils 
Arrows & Straighteners 
Axes 
Digging Sticks 
Hammers & Chisels 
Harpoons 
Knives 
Notch Tools 
Saws 
Side Scrapers 
Spear Throwers 

Leadership Qualities 
Vision 
Confidence 
Decisiveness 
Empathy 
Endurance 
Enthusiasm 
Fairness 
Honesty 
Responsibility 
Support 

Prehistoric Trivia 
Ages of Man 
Clothing 
Continental Drift 
Early Recyclers 
Gatherers & Hunters 
Glaciers 
Iron Pyrite 
Medicinal Herbs 
Piltdown Man 
The Shaman 

Tribal Society 
Ancestors 
Community 
Ecology 
Economy 
Family 

- ---.~ ~---.--------------------------.~--'---

Maturity 
Obligation 
Politics 
Male Initiation 
Female Initiation 

Ancient Mysteries 
Ancient Maps 
Creation Theory 
Dinosaurs Disappear 
Easter Island 
Evolution Theory 
Lost Continents 
Man's Ancestors? 
Mayan Calendar 
Pole Shifts 
Vortex Energy 

RECOMMENDED READING 

America B.C., Barry Fell, Wallaby Books, 1978. 

The Crystal Skull, Richard M. Garvin, Doubleday, 1973. 

Digging Dinosaurs, John R. Homer, Workman, 1988. 

The Dinosaur Heresies, Robert T. Bakker, Morrow, 1986. 

Easter Island: <The Mystery Solved, Thor Heyerdahl, Random House, 1989. 

Echoes of the Ancient Skies, Dr. E. C. Krupp, Harper & Row, 1983. 

EncyClopedia of Evolution, Richard Milner, Facts-On-File Publications, 1990. 

The Field Guide to Early Man, David Lambert and the Diagram Group, 

Facts-On-File Publications, 1987. 

The Great Dying, Kenneth J. Hsu, Ballantine, 1988. 

The Herb Identifier and Handbook, Ingrid Gabriel, Sterling Publishing, 1975. 

The Language of the Goddess, Marija Gimbutas, Harper & Row, 1989. 

Lost Cities of Ancient Lemuria & the Pacific, David Hatcher Childress, 

Adventures Unlimited Press, 1988. 

Man the Tool-Maker, Kenneth P. Oakley, Trustees of the British Museum of 

Natural History, 1965. 

Maps of the Ancient Sea Kings, Charles H. Hapgood, Dutton, 1979. 

The Mayan Factor: Path Beyond Technology, Jose Arguelles, Bear & Company, 

1987. 

Piltdown: A Scientific Forgery, Frank Spencer (based on research by Ian 

Langham: 1942-84), Natural History Museum Publications, Oxford 

University Press, 1990. 

Pole Shift, John White, Berkeley, 1980. 

Pyramid Energy: The Philosophy of God, The Science of Man, Dean & Mary 

Hardy and Kenneth & Marjorie Killick, Delta-K Pyramid Products, 1987. 

The Roots of Civilization,Alexander Marshack, Moyer Bell Limited, 1991.~ 

Saga America, Barry Fell, Times Books, 1983. 

Tao Te Ching, Lao Tzu, translated by Stephen Mitchell, Harper & Row, 1988. 

Tough-Minded Leadership, Joe D. Batten, American Management Association, 

1989. 

Unsolved Mysteries: Past and Pres~nt, Colin and Damon Wilson, Contemporary 

Books, 1992. 

Utne Reader, No. 52, July/August, 1992. 

With Bitter Herbs They Shall Eat It: Chemical Ecology and the Origins of 

Human Diet and Medicine, Timothy Johns, University of Arizona Press, 1990. 

You Can't Afford the Luxury of a Negative Thought, John-Roger & Peter 

McWilliams, Prelude Press, 1988. 
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CURRICULUM TARGETS 
AND SUBJECT AREAS 

Most of the educational 
objectives in THE LOST TRIBE 
are based on the curriculum 
guidelines for the states of 
Florida and Texas. 

Key acti"ities: 
t/ Strategy and planning 
t/ Decision making 
t/ Roleplaying 

Social Studies acti"ities 
included in THE LOST TRIBE: 
t/ Recognize major physical 

features represented on maps 
t/ Undertake personal leadership 

• ofa group 
t/ Apply the strategies of 

problem solving 
t/ Draw inferences from data 
t/ Interpret and evaluate 

conflicting opinions 
t/ Detect bias in sources of 

information 
t/ Understand the role of beliefs 

and traditions in a culture 

Critical Thinking skills 
reinforced in THE LOST 
TRIBE: 
t/ Locating and gathering 

information 
t/ Observing for detail 
t/ Distinguishing fact from 

opinion 
t/ Analyzing information 
t/ Synthesizing information 
t/ Drawing conclusions 
t/ Developing criteria for making 

judgments 
t/ Using problem-solving skills 
t/ Drawing inferences 
t/ Perceiving cause-effect 

relationships 
t/ Accepting the consequences of 

decisions 
t/ Valuing open-mindedness and 

tolerance of different opinions 

Language Arts Skills 
reinforced in THE LOST TRIBE 
(especially in the Random 
Events): 
t/ Identifying and evaluating 

main ideas 
t/ Choosing appropriate 

meaning in multi-meaning 
words 

t/ Arranging details in sequential 
order 

t/ Evaluating and making 
judgments 

CAST OF CHARACTERS 

Burgle 
Bloog 
Glurg 
Targ 
Brogo 
Gnarf 
Gupf 
B'Kaar 
Grampf 
Gurble 

Brett Bowers 
Tom Sullivan 
Chris Ray 
Todd Harris 
Holly Brooks 
Carol Swaffield 
Kim Rasey 
Kevin Bess 
Delbert Grouper 
Ed Brooks 

Other Tribe Members 
Brad Drenth 
Sherrie Eddy 
Jeremy Smith 
Linita Swaffield 
Joanne Wetherbee 

WARRANTY 

Lawrence Productions, Inc. warrants this program to the original 
purchaser for a period of 90 days from the date of purchase. If you have 
problems with this software, Lawrence Productions will replace it free 
of charge during the warranty period. This warranty applies to the 
diskettes and physical components only, not to the software program 
itself. Lawrence Productions is not responsible for any damage 
resulting from misuse of the program or errors in the program itself. 

Defective materials should be returned to: 

lAwrence Productions, Inc. 
~800 South 35th Street 
Galesburg, M149053-9687 
Phone:6~6-665-7075 

All returns must include the original distribution disks (or other 
materials if applicable) and a brief description of the problem. Please 
be sure to include your name, address and telephone number. 

This warranty shall not apply to disks that have been damaged by 
negligence, accident, improper or unreasonable use, or by any other 
causes unrelated to defective materials or workmanship. 

Please check warranty limitations in your state as some states have 
different ruling. This warranty gives you certain legal rights which may 
vary from state to state. Lawrence Productions, Inc. makes no express 
or implied warranties other than those stated above. 
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